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If you have followed through the Tutorials (Power*Log Metric Tutorial followed by the Power*Curve
Metric Tutorial) we will now have to add the Type Well Curve data to the Tutorial Wells Data. If you have
not done the Tutorials you will skip ahead to page 7 to import the Power*Curve Tutorial Well Before we
get started we have to add the Type Well Curve to the previously done Power*Curve Tutorial Well.

Adding the Type Well Curve
Congratulations on completing the tutorials. If that is the case then you will have to add the Type Well
TVD Curve layer to this log and then import the Las file to get the Type Well GR Curve into your well
data.

1.)

Double click on the

Icon. Acknowledge the Security Information window by clicking on the

button. This will initiate the program and activate a Connect Database window.

1.) Highlight the PGEOLOGY 2016 IMPERIAL (Microsoft Access Driver[*.mbd])) database by clicking on it once.
2.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.
3.) Type “pgeology” in the Password field and then click on the
various dictionaries and then activate an Open Log window.

button. The program will now load
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button. This will open your

9.) Under the Options menu, click on Log Configuration Builder or click on the
Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.

10.) On the left side of the Log configuration builder scroll down and highlight or click on the Curve track.
11.) Click on the Curve layer in the layers portion of the window on the lower left side of the builder to highlight it. In
addition, notice the Layers Radio button on the left side is activated.
12.) On the right side (Active Log) of the Log Configuration Builder window, click on the Drilling Progress
track to highlight it. This is the track we want to add the Type Well Curve layer to.
13.) Click on the

button and you will be prompted with the following system message, “Do you want to

ADD the selected (layer) from the available log to the active log?” Click on the

button.

14.) This will activate a Get Name window with “Type Well Curve” as the name in the New Layer Name field. Click
on the

button and the Type Well Curve layer will then be added to the Drilling Progress track.
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Note: The Type Well Curve has not yet been associated with the Type Well Curve layer. This will be done when the

Add Curve window has been correctly filled in when you exit the Log Configuration Builder window.
15.) Click on the
button to return to the log and the log will be initialized with the new layer, which in turn
will generate an Add Curve window.

The Add Curve window…
Type gapi in the Curve Units field.
Make sure ft is in the Depth Units drop box field.
Make sure the Null Value field is ‐999.25.
Make sure the Depth Interval is 0 and 0 indicating the
present curve scale is applicable to any depth on the log.
5.) Make sure the Curve Scale field values (Left / Bottom
and Right / Top) to 0 and 150
6.) Make sure the Backup Scale drop box field is Straight
Shift.
7.) Make sure the Grid type drop box field is Linear.

1.)
2.)
3.)
4.)

8.)

Click on the
button to add the Type Well Curve
layer to the Drilling Progress Track.

Importing the LAS Type Well Curve
1. Click on the File pull down menu selection and click on Import and then click on LAS from the pop
out‐menu or simply click on the
window.

LAS button, on the Import Toolbar, to activate the LAS Reader

2. This will then activate the Open window which allows the user to select the LAS file you wish to
import the data from. You can find the file in the PowerSuite_2016\System\PowerSteer Imperial
Gamma Ray type well.las and highlight the file by clicking on it once and then click on the
button. You will see the window shown below. It will default to the importing of Curve data.
3. On the lower left side of the window Click and drag the Gamma_Ray curve to the Type Well Curve
layer on the lower right side and release it when the layer name becomes highlighted.
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N.B. The user can Right click on the Curve Layer ID to remove the mapping or switch the action from
append to replace. The Symbol color will either be purple for replace or blue for append.
4. Click on the
finished.

button. You will then be prompted with a system message after the import has

5. Acknowledge the Finished Import message. Click on the
button and then click on the
button to exit or click on the File menu and select the Exit option to close the LAS Reader Window.

Removing the Type Well Curve Layer from the Tutorial Well HZ log.
This does not delete the type well curve but removes it from the log display.
1.) Under the Options menu, click on Log Configuration Builder or click on the
Log Configuration
Builder button on the Toolbar to activate the Log Configuration Builder window.
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2.) On the right side of the Log configuration builder scroll down and highlight or click on the Drilling
Progress track.
3.) Click on the Type Well Curve layer in the layers portion of the window on the lower right side of the builder to
highlight it. In addition, notice the Layers Radio button
4.)

Click on the

on the left side is activated.

button and you will be prompted with the following system message.

Note: The Type Well Curve data will not be deleted from the database. You are just deleting a layer that shows the
Type Well Curve data from the Tutorial Well HZ log.
5.)

Click on the

button.

6.)

Click on the

button to return to the log and the log will be initialized with this layer now deleted.

Power*Steer
Now we will start up the Power*Steer Portion of this Tutorial.

Connecting to the Database
1.) Double click on the Power*Steer
Database window.

Icon. This will initiate the program and activate a Connect
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4.) Highlight the PGEOLOGY 2016 IMPERIAL (Microsoft Access Driver[*.mbd])) database by clicking on
it once.
5.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the
User ID field. Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to
the Password field.
6.) Type “pgeology” in the Password field and then click on the
load various dictionaries and then activate a Well List window.

button. The program will now

7.) Double Click on the Tutorial Well or Highlight the Tutorial well and then click on the
button. Because this is the first time the Tutorial Well has been opened it will be a blank template
starting at zero depths with no scales.
If you have not done the Power*Log and or Power*Curve tutorials this Well will not be in the list. Then
we must import The Tutorial Well. If you have done the tutorials then skip ahead to page 11 Set Well
path.

Import Log / Well Data.
If you have followed all the tutorials you can skip ahead to page 10. If you have not done the Metric
Power*Log Tutorial followed by the Metric Power*Curve Tutorial you will have no data available to you
to do this Power*Steer tutorial We will make this easy and have you import the Metric Tutorial
Horizontal Well. This will have the majority of the data and we will have add a Type Well curve to finish
off the set up of a Power*Steer example.
1. Select Import under the File menu selection, and then select Log/Well from the sub‐menu. This will
activate the Import window.
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2.) Click on the
button. This will activate the Import from window and now you will have to
browse to find the folder C:\POWERSUITE_2016\SYSTEM and then the file name you want to
import is Metric Tutorial Horizontal Log.exp.

Note that files available for importing will have an .EXP file extension. Any of the files that you select will
then be added to the File list. Please make sure that the files you wish to import are highlighted
(selected), in the list prior to importing.
3.) Highlight the file name and click on the
button.
4.) The Import Log/Well window will now be displayed with the details of the file to be imported.
Select/highlight the file to be imported.
5.) Click on the
button to activate the following system message, “Do you really want to
IMPORT the highlighted files?”
6.) Click on the

button to proceed with the import.

Note: If you click on the “Yes” button, and the file you are importing contains the information from an
Entire Well, the following system message will be activated, “About to IMPORT ENTIRE WELL data. All
information associated with this well in the database will be OVERWRITTEN. Continue?”
7.) Click on the
button.
8.) Upon completion of the import, the following system message will then be activated, “Data has
been imported successfully.”
9.) Click on the

button to confirm the successful import of the data.

10.) Close the Data Transfer window by clicking on the
located at the top right of the Data Transfer window.

button or by clicking on the

icon
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Refresh Data
If the well was opened and you have imported a newer file the Power*Steer
application must be refreshed to see the new data that has been imported.
Because we did not have the well opened at this time you would not have to
do this step. To refresh the data you would.
1.) Click on the File Menu to activate the drop down list and Click on the
Refresh Data Selection to refresh the well’s data you have open in
Power*Steer.

Open Well
Now you have imported the Tutorial Well we now have to open the well.
1.) Click on the File Menu to activate the drop down list and click on the Open Selection to activate the
Well List.

2.) Select the Tutorial Well by double clicking on the well name or highlighting once and click on the
button.
This will open the Power*Steer with 2 panes and no data shown with the depths defaulted to zero (0).
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Power*Steer Well data needed from Power*Log / Power*Curve.







A Well Path (TVD units) Curve has to be added and then calculated from the survey data.
Survey data must also be up to date to display the information on the Power*Steer application.
A measured depth Gamma Ray Curve must exist for the well being steered.
A Type Well Gamma Ray Curve (TVD) must exist for the well to be steered.
Zone of interest must be known and identified on the Type well.
Formation Tops may be added and also have to have the thickness calculated in order to show
up in the list to be drawn in Power*Steer.

Set Well Path
1. Right click on the Well Path pane (right side) to activate the pop out menu
2. Select Set Well Path. This will activate a Select Curve Window.

3. Select the steered Well Path Curve in TVD units from the drop down list by clicking on the down
arrow and selecting it from your curve list for this well from your database.
4. Click on the
button.

Set the Gamma Curve
1. Right click on the Well Path pane (right side) to activate the pop out menu
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2. Select Set Gamma. This will activate a Select Curve Window.

3. Select the steered wells Gamma Ray curve in measured depth units from the drop down list by
clicking on the down arrow and selecting it from your curve list for this well from your
database.
Note: This Gamma Ray curve will be displayed on the lower portion of the well path and will either be
displayed in MD or VS depth units depending on the view. This is the curve that you will be attempting
to correlate to the Type Well Curve. It doesn’t necessarily have to be the Gamma Curve but this tool is
by far the most common tools to be run downhole while drilling.
4. Click on the

button.

Set the Overlay Curves
If the user wishes to have more curves displayed on the Segment portion of the window the user can
also display those curves in either MD or vertical section depth display. These are only for display
purposes and will not be used to correlate to the Type Wells data.
1. Right click on the Well Path pane (right side) to activate the pop out menu
2. Select Overlay Curves. This will activate an Overlay Curves list.

3. Select the Total Gas curve from the list and you may display other curves captured in your wells
database. Display these curves data by activating the check box beside the curves.
Note: These Overlay curves will be displayed on the lower portion of the well path and will either be
displayed in MD or VS depth units depending on the view. These curves are for display purposes only.
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4. Click on the

button.

Set Type Well Curve
1. Right click on the Type Well portion of the screen (left side)
2. Select Set Type Well Curve from the pop out menu list. This will activate a Select Curve list.

3. Select the Type Well Curve that you will be steering to. This is Type Well GR curve you imported
into your steered well in Power*Curve.
4. Click on the
button.

Type Well Depth Manipulation
Go To Depth (Type Well)
1. Click on the Type Well Portion of the window.
2. Click on the View Menu to activate the drop down list.
3. Click on Go To Depth (Type Well) selection to activate the Goto
Window.
4. Type a 7860 in the Type Well Depth Field.
button. This will change the depth view from 0
5. Click on the
to 7860 at the top of the type well.
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Type Well Track Depth Scrolling
Once the Type Well curve has been added to this track the user has the ability to scroll up and down the
curve depth display.

Mouse Pointer Controls
The user can click on the up / down arrows on the right side of the
track pane to move up or down a bit or click on the space between
the thumb and arrows to move up or down 1/4 page.

Mouse Roller Ball Control
Click on the Type Well pane and then roll the roller ball away from
you to scroll up the view.
Click on the Type Well pane and then roll the roller ball towards you
to scroll down the view.

Type Well Display Scale Manipulation
Click on the Type Well pane, hold the CTRL Key down on the keypad
and then roll the roller ball away from you to decrease the scale so
that you can see less data in the Type Well.
Click on the Type Well pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Type Well.

Go To Depth (Well Path)
1.
2.
3.
4.

Click on the Well Path Portion of the window.
Click on the View Menu to activate the drop down list.
Click on Go To Depth (Well Path) selection to activate the Goto Window.
Type a 660 in the Well Path Depth Field.

5. Click on the

button.

Well Path MD/VS Gamma Ray Depth Scale Display Manipulation
Click on the Well Path pane, hold the CTRL Key down on the keypad and then
roll the roller ball away from you to decrease the scale so that you can see less data in the Well Path
and MD / VS Gamma Ray.
Click on the Well Path pane, hold the CTRL Key down on the keypad and then roll the roller ball
towards you to increase the scale so that you can see more data in the Well Path and MD / VS Gamma
Ray.
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Well Path TVD Scale manipulation
Mouse Pointer Controls
The user can click on the up / down arrows on the right side of the track pane to move up or down a bit
or click on the space between the thumb and arrows to move up or down 1/4 page. This will move all
the scales (both top and bottom scales simultaneously).

Mouse Roller Ball Control
Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball
towards you will move the TVD scale down (both top and bottom scales simultaneously).
Click on the Well Path pane, hold the Shift Key down on the keypad and then roll the roller ball away
from you will move the TVD scale up (both top and bottom scales simultaneously).
Click and drag up on the Well Path portion of the pane to see a more detailed view or less TVD range.
This action will not move the bottom TVD scale.
Click and drag down on the Well Path portion of the pane to see a less detailed view or more TVD range.
This action will not move the bottom TVD scale.

Well Path MD/VS Gamma Ray Depth Manipulation
Once the Well Path TVD curve, Measured Depth Gamma Ray curve has been added to these track the
user has the ability to scroll left and right to change the curve depth display.
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Mouse Pointer Controls
The user can click on the left / right arrows on the bottom side of the track pane to move left or right a
bit or click on the space between the thumb and arrows to go left or right 1/4 page.

Mouse Roller Ball Control
Click on the Well Path pane and then roll the roller ball away from you to scroll left or back.
Click on the Well Path pane and then roll the roller ball towards you to scroll right or forward.

Curve Display and Grid Pattern Manipulation
1. Right Click anywhere in either pane to activate the pop out menu.
2. Select General Properties. This will activate the General Properties window.

Right Click Type Well Pane
Right Click Well path Pane
3. The default Tab selection is the Curve Setting tab. So now Click on the drop arrow and select the
Type Well curve to change the display for.

4. Line Size portion of the window will change the line thickness from 1 to 20 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.
5. Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line
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6. Scale Portion of window allows the user to change scales for the selected curve. Type a value in
the appropriate fields to change the scales. The scales will change as you type.
7. Grid Portion of window allows the user to change the grid pattern for the selected curve. Type a
value in the appropriate fields to change the grids. The grids will change as you type. Major
Grids will indicate a value. The minor grids will divide the whole track and not the majors.
8. Ignore NULL’s check box when activated will join curve values ignoring the null values. When
deactivated the curve will only draw when there are two consecutive data points.
9. Repeat Steps 6‐8 to change the appearance of the other curves presented in Power*Steer.
10. Click on the

in the upper right hand corner to exit this window.

Adding Zones
We will now add some Zones to the Type Well. They could be formation tops or other indicators that
you wish to mark on your Type Well and will be transposed and manipulated by your segment
movements in the Well Path pane.
1. Right Click at 7892 on your Type Well pane to activate the pop out menu.
2. Select Add Zone from the pop out menu list. This will activate the Add Label window.

3. Type in a Red Sky in the field provided.
4. Click on the
button. This will close the window and add the Red Sky Zone Label to the Type
Well pane.
Note: The label will only be seen on the Well Path Pane after you have added a Reference Point
5. Right Click at 7906 on your Type Well pane to activate the pop out menu.
6. Select Add Zone from the pop out menu list. This will activate the Add Label window.

7. Type in a Red Sky Main Sand in the field provided.
8. Click on the
button. This will close the window and add the Red Sky Main Sand Zone Label to
both the Type Well pane.

Power*Steer Tutorial Page 17

2016

Power*Steer Tutorial

9. Right Click at the 7969 on your Type Well pane to activate the pop out menu.
10. Select Add Zone from the pop out menu list. This will activate the Add Label window.

11. Type in a ZOI (Top) {ZOI is an acronym for Zone of Interest} in the field provided.
This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.
12. This is the primary target label indicator then you must click on the
button.
13. Click on the
button. This will close the window and add the ZOI (Top) label to the Type Well
pane.
14. Right Click at the 7974 on your Type Well pane to activate the pop out menu.
15. Select Add Zone from the pop out menu list. This will activate the Add Label window.

16. Type in a ZOI (Base) {ZOI is an acronym for Zone of Interest} in the field provided.
This is a zone marker that indicates that you are inside the designated target and you would like to
calculate the percentage of the well’s path that is inside the target boundaries then you must
indicate whether this label is the top or base of the Zone. The user can only have one label
designated at top and one zone label that is designated as base.
17. This is a primary target label indicator then you must click on the
button.
18. Click on the
button. This will close the window and add the ZOI (Base) to the Type Well
pane.
19. Right Click at 7990 on your Type Well pane to activate the pop out menu.
20. Select Add Zone from the pop out menu list. This will activate the Add Label window.
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21. Type in a Red Sky Basal Shale in the field provided.
22. Click on the
button. This will close the window and add the Red Sky Basal Shale Zone Label
to the Type Well pane.
The zone labels will be added to the Well Path Pane after you put in a reference point and then add the
first segment.

Zones Display Properties
1. Right Click anywhere in either pane to activate the pop out menu.
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2. Select General Properties. This will activate the General Properties window.
3. Click on the Zones Tab to activate the Zones display properties.
Note: Zones will only appear in this list if they been entered in the Type Well Portion (left side) of the
Geo*Steer application.
4. Click on the drop arrow and select the zone you wish to change the display for.
You can change the display name if you wish by typing in a new Zone name. These can be tops or any
other indicators you wish to display in the Well Path Section of the Geo*Steer application.

5. If you wish to change the color of the Zone line then you can click on the
button to
activate the Color pallet. Select a new color and then click on the
button.
6. Line Size portion of the window will change the line thickness from 1 to 9 (pixels wide). You
have to type a number in the size field and your input will be automatically displayed by the
curve.
7. Line Style portion of the window will change the line style. You have to type a number in the
style field from 0 to 3 and your input will be automatically displayed by the curve. 0=Solid line,
1=Dashed Line, 2=Dotted Line, 3=Dash Dot Line.
8. If you choose to change the Type Well depth and or the
Base or Top of zone
then you must click on the
button
9. Repeat steps 4‐8 for changes to other zone lines.
10. Click on the

in the upper right hand corner to exit this window.
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Set Reference Point
First thing you have to do is set up a reference point. You will need to know the general strike and dip of
the formation you wish to steer this well for and the depth offset so that you can move the steered
wells curve data up or down to match near the zone of interest. This offset is critical for display
purposes and should be correlated to the last Formation top encountered before the zone of interest
to be drilled along is encountered. This can be changed after the fact but will affect the segments that
have been manipulated if done after the fact. The Strike and Dip will not be allowed to change. If you do
want to change the strike and dip then you will have to delete the Reference point and that will delete
all the segments that have been entered so you will be starting anew.
So it is quite important not to set up this reference point too soon as the segment manipulation is quite
dependent on dip and if your well bore is less than 80 degrees inclination then you are manipulating bed
thickness and not bedding dip, azimuth and or faulting.
1. Right Click on the Type Well Pane at 7740 which is a little above the depth that we wish to start our
correlations and select Set Reference Point from the pop out menu. This will activate the Reference
Point window.

Note: The Reference Points Dip and Azimuth refers to the regional Strike and Dip in the area for your
drilled zone of interest. The Type Well Offset moves your steered well up or down to match with the
Type well. A negative number will move your steered well being drilled up and a positive number in this
field will move your correlatable well down. This offset and steering should really be done when you are
near your zone of interest.
2. In the Reference Point window the default Dip and Azimuth are OK for this tutorial. Normally the
user will fill in the Regional strike and dip. The defaults are (1 degree) and strike azimuth (315
degrees) for our intended formation or zone you wish to steer.
3. Tab key to advance and highlight to the Type Well Offset field and type ‐0.5 in the Type well offset.
4. Click on the
button. Once the reference point has been set you will see a pink line in both
the Type Well and your correlating well as shown above
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Segments
This is the nuts and bolts of the Power*Steer application and we should spend some time explaining
what a segment does for you. A segment consists of various integral pieces of data that has Vertical
Section depths from and to, Measured Depths from and to, True Vertical Depths from and to along with
Dip angle, Azimuths and throws. All the Segment data is manipulated on the type well by shrinking and
extending the VS start and VS end points, moving the entire segment to create a throw (indicated by a
fault on the Well Path Pane) or changing the Segment Azimuth.

Segment Definition
A segment is a depth range on the Gamma Ray trace (either MD or VS depth range) that is then
converted to TVD depth on the Trace Well. To select a segment you will have to click on the segment
marker (arbitrary color) which is defined below the Vertical Section / Measured Depth Gamma Ray trace
from the active well. Once the segment is clicked on you will see the Steered Well Gamma Ray curve
(turns red) to make it active on the Type well and it will have a VS start line and VS finish line on both
the Type Well and Well Path Panes. The Gamma Ray trace may go down or up or both depending on the
well path over the segment interval. The segment trace on the Type well will appear red when going
down and black when going up.

Add the first Segment
(First one is different than all the rest) The top of this segment cannot be
refined with a change of dip or azimuth. It is just a starting point. The rest of
the segments after the first can be redefined on both the VS Start and VS End
or create some faulting.
1. Right Click @ 7742 somewhere near, (but deeper than your reference
point and Select Add Segment from the pop out menu.
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The first segments Gamma Ray data will be displayed on your Type Well as a red curve and will be
placed at the offset depth that was entered into your Set Reference Point. The display depths for the
Gamma Ray curve on the Type Well pane have been recalculated from its Measured Depth / Vertical
Section Depths to True Vertical Depth so the user can attempt to correlate to the type Well. The first
segment will extend to the end depth of your current Survey data and will omit any Gamma Ray Curve
data beyond that as it does not have any TVD depths associated to represent that data.
Note: You can only manipulate the bottom of this first segment (VS End).

Adding more Segments.
1. Right Click @ 771 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.
2. Right Click @ 787 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the pop
out menu.
3. Click on the segment just created from 771 to 787 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and
right) the cursor will turn into a as shown above.
3. Click and drag the VS End down to match the GR peak in the type well. This will change the
bedding angle from 0.42 to approximately 1.71 degrees.
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Extending the Segment
1. Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 2371. This is where the GR Segment changes and does not perfectly match the
Type well.
2. You can also hold the Shift key down and Mouse over the end of the segment on the Well Path
pane and when it turns into an
arrow click and drag left or right to shrink or extend the
segment.
You may have to click on the Type Well pane if you see the scale change in the Well Path pane.
3. You will want to double click on the Red Segment from 771 to 787 and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment
1. Right Click @ 830 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
2. Click on the segment just created from 787 to 830 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and
right) the cursor will turn into a as shown above.
4. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.40 to approximately ‐0.65 degrees.
5. You will want to double click on the Red Segment from 787 to 830 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
3. Right Click @ 984 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
4. Click on the segment just created from 830 to 984 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.

Changing the bedding angle of a Segment
6. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
7. If you were to move the mouse pointer to hover over the VS End marker (greed line above and
right) the cursor will turn into a .
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.42 to approximately 0.03 degrees.
7. You will want to double click on the Red Segment from 830 to 984 and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1181 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 984 to 1181 VS to highlight the Gamma Ray section (Red
(Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and
right) the cursor will turn into a as shown above.
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.45 to approximately ‐.04 degrees.

Extending the Segment
1. Then hold the Shift key down and roll the scroll button on your mouse towards you and stop
when it gets to 7956. This is where the GR Segment changes and gets a little off below this
depth.
2. Or You can also hold the Shift key down and Mouse over the end of the segment on the Well
Path pane and when it turns into an
arrow click and drag right to extend the segment to
1626.
3. You will want to double click on the Red Segment from 984‐1626 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1706 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1626 to 1706 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (purple line above and
right) the cursor will turn into a up/down arrow.
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.68 to approximately ‐0.55 degrees.
7. You will want to double click on the Red Segment from 1626 to 1706 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 1853 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1706 to 1853 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (blue line above and
right) the cursor will turn into a up/down arrow.
6. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.6 to approximately ‐0.7 degrees.
8. You will want to double click on the Red Segment from 1706 to 1853 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. Right Click @ 2043 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
3. Click on the segment just created from 1853 to 2043 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators. This where the well goes from getting deeper to getting shallower.

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown below) to highlight the
segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and
right) the cursor will turn into a up/down arrow.
3. Click and drag the VS End up to match the GR peak in the type well. This will change the
bedding angle from 0.6 to approximately 0.04 degrees.
4. You will want to double click on the Red Segment from 1853 to 2043 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. You will now want to expand the Type Well Scale by Clicking on this pane and holding the CTRL
Key down and rolling the roller ball on your mouse away from you to increase the scale.
3. Right Click @ 2257 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
4. Click on the segment just created from 2043 to 2257 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.

Power*Steer Tutorial Page 33

2016

Power*Steer Tutorial

Changing the bedding angle of a Segment
1. Click once on the Segment Marker below the Gamma Ray curve (shown on previous page) to
highlight the segment on the Type Well.
2. If you were to move the mouse pointer to hover over the VS End marker (blue line above and
right) the cursor will turn into a up/down arrow.
3. Click and drag the VS End down to match the GR low reading in the type well. This will change
the bedding angle from 0.71 to approximately 1.32 degrees.
4. You will want to double click on the Red Segment from 2043 to 2257 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.

Adding another Segment
1. Scroll down (deeper) on the Type Well pane and scroll right (deeper) on the Well Path pane.
2. You will now want to expand the Type Well Scale by Clicking on this pane and holding the CTRL
Key down and rolling the roller ball on your mouse away from you to increase the scale.
3. Right Click @ 2600 VS on the Well Path / Gamma Ray Pane and Select Add Segment from the
pop out menu.
4. Click on the segment just created from 2257 to 2600 VS to highlight the Gamma Ray section
(Red (Well bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS
end indicators.
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Changing the bedding angle of a Segment
4. Click once on the Segment Marker below the Gamma Ray curve (shown on previous page) to
highlight the segment on the Type Well.
5. If you were to move the mouse pointer to hover over the VS End marker (blue line above and
right) the cursor will turn into a up/down arrow.
6. Click and drag the VS End down to match the GR low reading in the type well. This will change
the bedding angle from 0.21 to approximately 0.7 degrees.
5. You will want to double click on the Red Segment from 2257 to 2600 VS and this will keep the
segment visible on the Type Well after you initiate the next segment.
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The Last Segment
1. Scroll right (deeper) on the Well Path pane.
2. Click on the segment from 2600 to 2976.74 VS to highlight the Gamma Ray section (Red (Well
bore heading down) / Black (Well Bore heading up) and you will see VS Start and VS end
indicators.
3. As far As I can tell they are lined up over each other so you are now done with the Power*Steer
portion of the tutorial.

Zone Fills
The zone fills option adds some color to the final product.
1. Right Click on the Well Path / GR Panes to activate the pop out menu.
2. Select Show/Hide Zone Fill. This will turn on the Zone fill color scheme shown
below.
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Calculate In / Out
This menu selection works with the zones that were added and where the zones were indicated as the
top and base. When those are defined the user can select this Edit menu selection and it will calculate
the amount of well path that is in the zone and the amount of well path that is out of the zone. This
calculation is started when the well path first encounters the top of your zone of interest.
1. Click on the Edit Menu to activate the drop down list and select Calculate In / Out.
This will be printed in the output as well as displayed in the Status bar when your
mouse pointer is focused in the Well Path portion of the window.
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Print
1. Click on the File Menu to activate the drop down list.
2. Click on Print selection or click on the
Print button on the Toolbar to
activate the Print Options window shown below.
3. VS / MD Range portion of the window indicates the Vertical Section
depth range or Measured Depth Range you wish to print. Type in the
depth range in the fields provided.
(Your Power*Steer application may be in Measured Depth [MD Range] units.)
4. Well Path Scale portion of the window indicates the TVD depth range you wish to print. Type in
the TVD depth range in the fields provided.
5. Type Well Width field is how wide you want to print this portion of the Power*Steer window.
Type in a width in Inches in the field.
The depth scale interval and scale of the Type well will be determined by what is viewed on your screen
and the paper size an orientation.
6. Border field is how much border you wish to
have around the top, bottom, and left edges
of your print. Type in a border width in
inches in the field.
7. Print field drop box is the VS Depth Scale of
your print. Click on the drop box and select
from the List or the user can also Type a VS
depth scale in the field.
8. Click on the Service Company logo
button to search your computer for a logo to
put in your header.
9. Type in the Type Well Name / Location is
the Type Well field. Depress the tab key on
your keypad to advance the cursor to the
Interpreter field.
10. Type in the Interpreters name who created the interpretation in the Interpreter field.
button allows the user to setup the printer for the Power*Steer output
11. When you are ready to print your Power*Steer log, click on the

button.

Power*Curve / Power*Steer display
This is another way to display the lithology in the Power*Curve module in the detailed lithology track of
our default logs. The normal curve fill would be the well path but we will now show you a Power*Steer
curve fill layer.

Connecting to the Database

1.)

Double click on the

Icon. Acknowledge the Security Information window by clicking on the

button. This will initiate the program and activate a Connect Database window.
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2.) Highlight the PGEOLOGY 2016 IMPERIAL (Microsoft Access Driver[*.mbd])) database by clicking on it once.
3.) Move your mouse pointer to the User ID field and click. This will activate a flashing cursor in the User ID field.
Type “pgeology” in the User ID field. Press the Tab key on the keyboard to move to the Password field.
4.) Type “pgeology” in the Password field and then click on the
various dictionaries and then activate an Open Log window.

button. The program will now load
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5.) Select the Tutorial Well from the List and then click on the
Well Horz Log.
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6.) Click on the Detailed lithology track once to highlight the track in green.
7.) Click on the layer Selection list and click on or select the Curve fill layer. This will make active the
Curve fill layer.
8.) Double click anywhere within the Curve Fill layer to activate the Curve Fill Options window. This will activate
the Choose Curve Editor shown below.

9.) Click on the

button to activate the Curve Fill Options window.

10.) Click on the Fill Modes – 1 Curve drop box and Select Power*Steer.
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11.) Click on the
button in the Curve fill Options window. The window will close and the changes you have made
will be reflected on the layer.

This concludes your Power*Steer Tutorial

Power*Steer Tutorial Page 42

